
 
 

Руководство пользователя и 
технические характеристики  
NI 6583R 

NI 6583R - несимметричное и дифференциальное сигнальное устройство, 

предназначенное для совместной работы с вашим модулем NI FlexRIO FPGA.  

NI 6583 доступен в двух вариантах: один с низкоуровневыми дифференциальными 

сигналами (LVDS), и другой с многоточечными низкоуровневыми 

дифференциальными сигналами (MLVDS). Термин "дифференциальный" в данном 

документе означает и сигналы LVDS, и сигналы MLVDS, если не указано иное. 

В данном документе содержатся информация о сигналах и технические 

характеристики модуля NI 6583R, состоящего из модуля NI FlexRIO FPGA и  

NI 6583. В этом документе содержатся также разделы руководств, показывающих, 

как собирать данные, используя пример LabVIEW FPGA VI, а также как создавать 

и выполнять собственный проект LabVIEW c NI 6583R. 
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Примечание Прежде, чем конфигурировать NI 6583R, необходимо 

инсталлировать соответствующее программное обеспечение и аппаратные 

средства. Руководство по установке приведено в документе NIFlexRIO FPGA 

Module Installation Guide and Specifications. На рисунке 1 показан пример 

правильно подключенного устройства NI FlexRIO. 

Рисунок 1. NI 6583R 

 

 
NI 6583 + Модуль 

 NI Flex RIO FPGA 
=    NI 6583R 

 

 

Примечание NI 6583R означает комбинацию адаптера модуля NI 6583R и модуля 

NI FlexRIO FPGA. NI 6583 означает только адаптер модуля NI 6583. 
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Как использовать ваш комплект документации 
NI FlexRIO 

Обратитесь к рисунку 2 и таблице 1, чтобы узнать, использовать ваш комплект 

документации NI FlexRIO. 

 

Рисунок 2. Как использовать ваш комплект документации NI FlexRIO 
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Таблица 1. Местоположение и описание документации NI FlexRIO 
 

Документ Местоположение Описание 

Руководство по 

установке и технические 

характеристики модуля 

NI FlexRIO FPGA* 

Доступно в 

комплекте 

поставки модуля 

FPGA и из меню 

Пуск. 

Содержит инструкции по 

установке вашей системы NI 

FlexRIO и технические 

характеристики вашего модуля 

FPGA. 

Руководство 

пользователя и 

технические 

характеристики 

адаптера модуля NI 

FlexRIO 

Доступно в 

комплекте с вашим 

адаптером модуля и 

из меню Пуск. 

Содержит информацию о 

сигналах, примеры и технические 

характеристики вашего адаптера 

модуля. 

Справка LabVIEW 

FPGA Help* 

Встроена в 

справку LabVIEW 

Help. 

Содержит информацию о базовой 

функциональности модуля 

LabVIEW FPGA. 

Справка NI FlexRIO* Встроена в справку 

LabVIEW FPGA 

Help. 

Содержит информацию по 

конфигурированию модуля FPGA, 

адаптера модуля и CLIP. 

Примеры LabVIEW Доступны в 

поисковике 

примеров NI 

Example Finder. 

Содержат примеры FPGA VI и 

хост-VI на вашем устройстве. 

Другая полезная информация на сайте ni.com 

ni.com/ipnet Содержит функции LabVIEW FPGA и IP-ядра совместного 

пользования. 

ni.com/flexrio Содержит информацию о продуктах и технические 

характеристики устройств NI FlexRIO. 

* эти документы доступны также на сайте ni.com/manuals. 
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Лицевая панель и схема расположения 
контактов разъемов 

На рисунке 3 показано назначение контактов разъема цифровых данных и 

управления (DDC) NI 6583. Разъем DDC A используется для несимметричных 

линий, а разъем DDC B – для дифференциальных. 

 

Рисунок 3. Назначение контактов разъемов NI 6583 
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Внимание Подключение сигналов, которые превышают любое из максимальных 

значений входных или выходных сигналов NI 6583R, могут повредить 

устройство и шасси. NI не несет ответственность за повреждения, вызванные 

подобными подключениями сигналов. Максимальные значения входных и 

выходных всех сигналов приведены в разделе Технические характеристики 

данного документа 

 

Примечание При разработке пользовательского кабеля на основе разъема DDC B 

(779157-01) дифференциальных линий и кабеля NI SHB12X-B12X (192344-01), 

схема расположения выводов NI 6583 на конечном разъеме - обратная. Например, 

сигнал, показанный для контакта 1 на рисунке 3, будет соответствовать контакту 

73 конечного разъема.  

Таблицы контактов и сигналов 
В таблице 2 содержатся расположение контактов и информация о несимметричных 

сигналах на разъеме DDC A устройства NI 6583. 
 

Таблица 2. Контакты разъема NI 6583 DDC A 
 

Название 

сигнала 

Контакт(ы) Тип сигнала Описание сигнала 

DDC CLK OUT 33 Тактовый Контакт для несимметричного 

экспортируемого сигнала Sample clock. 

STROBE 67 Тактовый Внешний источник сигнала Sample clock, 

который может использоваться для 

синхронного сбора данных. 

DIO <0..31> 1, 3, 5, 7, 9, 11, 13, 15, 

17, 19, 21, 23, 25, 27, 

29, 31, 35, 37, 39, 41, 

43, 45, 47, 49, 51, 53, 

55, 57, 59, 61, 63, 65 

Данные Двунаправленные несимметричные 

каналы цифрового ввода-вывода  

с 0 по 31.  

PFI <1..3> 26, 30, 64 Управление/ 

данные 

Двунаправленные несимметричные 

каналы цифрового запуска с 1 по 3.  

GND 2, 4, 6, 10, 12, 14, 16, 

18, 20, 22, 24, 28, 32, 

34, 36, 38, 40, 42, 44, 

46, 48, 50, 54, 56, 58, 

62, 66, 68 

Общий 

провод 
(Ground) 

Общий провод для источников сигналов 

(Ground reference). 

RESERVED 8, 52, 60 — Эти контакты зарезервированы для будущего 

использования. Не подключайте эти контакты. 
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В таблице 3 содержатся расположения контактов и информация о 

дифференциальных сигналах для разъема DDC B устройства NI 6583. 
 

Таблица 3. Контакты разъема NI 6583 DDC B 
 

Название сигнала Контакт(ы) Тип сигнала Описание сигнала 

DDC CLK OUT+ 65 Тактовый Положительный контакт для 

дифференциального экспортируемого 

тактового сигнала. 

DDC CLK OUT– 66 Тактовый Отрицательный контакт для 

дифференциального экспортируемого 
тактового сигнала. 

STROBE+ 62 Тактовый Положительный внешний источник тактового 

сигнала, который может использоваться для 

динамического сбора данных.  

STROBE– 63 Тактовый Отрицательный внешний источник тактового 

сигнала, который может использоваться для 

динамического сбора данных.  

DIO <0..15>+ 14, 17, 20, 23, 26, 

29, 32, 35, 38, 41, 

44, 47, 50, 53, 56, 

59 

Данные Положительные двунаправленные каналы 
цифрового ввода-вывода с 0 по 15.  

DIO <0..15>– 15, 18, 21, 24, 27, 

30, 33, 36, 39, 42, 

45, 48, 51, 54, 57, 

60 

Данные Отрицательные двунаправленные каналы 
цифрового ввода-вывода с 0 по 15.  

PFI <1..3>+ 2, 5, 8 Control Положительные двунаправленные каналы 
цифрового запуска с 1 по 3.  

PFI <1..3>– 3, 6, 9 Control Отрицательные двунаправленные каналы 

цифрового запуска с 1 по 3.  

GND 1, 4, 7, 10, 13, 16, 

19, 22, 25, 28, 31, 

34, 37, 40, 43, 46, 

49, 52, 55, 58, 61, 

64, 67, 70, 73 

Общий 

провод 
(Ground) 

Общий провод для источников сигналов 

(Ground reference). 

RESERVED 11, 12, 68, 69, 71, 

72 

— Эти контакты зарезервированы для будущего 

использования. Не подключайте эти контакты. 

 

Блок-схемы 
На рисунках 4 - 7 показан поток данных через NI 6583R. Несимметричные линии 

данных используют стандартизированные уровни напряжения для интерпретации 

данных как двоичный ноль или единица при высокоскоростной передаче цифровых 

данных. Дифференциальные линии данных предоставляют дифференциальный 

метод высокоскоростной передачи цифровых данных, отличающийся низким 

уровнем помех, низком мощностью и невысокой амплитудой.  
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Рисунок 4. Входные тактовые сигналы 

 
 

Рисунок 5. Дифференциальные линии данных и линии PFI 

 
 

Рисунок 6. Несимметричные линии данных и линии PFI 
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Рисунок 7. Выходные тактовые сигналы 

 

В таблицах 4 и 5 приведены сигналы разъема NI 6583 и соответствующие сигналы 

модуля NI FlexRIO FPGA, необходимые для разработки пользовательских IP на 

компонентном уровне (CLIP). Суффиксом _CC в обозначениях дифференциальных и 

несимметричных сигналов идентифицируются каналы, способные принимать 

локальный тактовый сигнал. Обратитесь к разделу Блок-схемы данного документа для 

получения дополнительной информации о подключении сигналов от  

NI 6583 к модулю FPGA. 

Таблица 4. Несимметричные сигналы NI 6583 и сигналы модуля NI FlexRIO FPGA 
 

NI 6583 Модуль NI FlexRIO FPGA 

Разъем Название 

сигнала 

Ввод-вывод GPIO Направление GPIO 

DDC A (несимметричный 
вход/выход) 

DIO 0 GPIO_16_n GPIO_16 

DIO 1 GPIO_2_n GPIO_2 

DIO 2 GPIO_19_n GPIO_19 

DIO 3 GPIO_5_n_CC GPIO_5_CC 

DIO 4 GPIO_20_n GPIO_20 

DIO 5 GPIO_4_n_CC GPIO_4_CC 

DIO 6 GPIO_7_n_CC GPIO_7_CC 

DIO 7 GPIO_3_n GPIO_3 

DIO 8 GPIO_23_n_CC GPIO_23_CC 

DIO 9 GPIO_6_n_CC GPIO_6_CC 

DIO 10 GPIO_22_n GPIO_22 

DIO 11 GPIO_21_n GPIO_21 

DIO 12 GPIO_25_n_CC GPIO_25_CC 

DIO 13 GPIO_10_n GPIO_10 

DIO 14 GPIO_24_n_CC GPIO_24_CC 

DIO 15 GPIO_9_n GPIO_9 

DIO 16 GPIO_12_n GPIO_12 

DIO 17 GPIO_8_n GPIO_8 

DIO 18 GPIO_27_n GPIO_27 

DIO 19 GPIO_28_n GPIO_28 

DIO 20 GPIO_11_n GPIO_11 

DIO 21 GPIO_26_n_CC GPIO_26_CC 

DIO22 GPIO_30_n GPIO_30 
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Таблица 4. Несимметричные сигналы NI 6583 и сигналы модуля NI FlexRIO FPGA 
(продолжение) 

NI 6583 Модуль NI FlexRIO FPGA 

Разъем Название 

сигнала 

Ввод-вывод GPIO Направление GPIO 

DDC A (несимметричный 

вход/выход) 

DIO 23 GPIO_15_n GPIO_15 

DIO 24 GPIO_29_n GPIO_29 

DIO 25 GPIO_14_n GPIO_14 

DIO 26 GPIO_50_n GPIO_50 

DIO 27 GPIO_13_n GPIO_13 

DIO 28 GPIO_32_n GPIO_32 

DIO 29 GPIO_31_n GPIO_31 

DIO 30 GPIO_49_n GPIO_49 

DIO 31 GPIO_33_n GPIO_33 

PFI 1 GPIO_0_n GPIO_0 

PFI 2 GPIO_18_n GPIO_18 

PFI 3 GPIO_1_n GPIO_1 

STROBE GClk_SE — 

CLK OUT GPIO_17_n GPIO_17 

(если разрешено) 
 

Примечание Линии DIO и PFI настраиваются на выход сигналом GPIO Direction 

высокого уровня, а на вход сигналом GPIO Direction низкого уровня. Сигнал 

высокого/низкого уровня открывает/закрывает линию CLK OUT. 

Таблица 5. Дифференциальные сигналы NI 6583 и сигналы модуля NI FlexRIO FPGA 
 

NI 6583 Модуль NI FlexRIO FPGA 

Разъем Название 

сигнала 

Вход GPIO Выход GPIO Направление 

GPIO 

DDC B 

(Дифферен-
циальный 

вход/выход) 

DIO 0+/– GPIO_48 GPIO_47_n GPIO_48_n 

DIO 1+/– GPIO_44_n GPIO_45 GPIO_45_n 

DIO 2+/– GPIO_41 GPIO_40_n_CC GPIO_40_CC 

DIO 3+/– GPIO_61 GPIO_60_n GPIO_60 

DIO 4+/– GPIO_62 GPIO_61_n GPIO_62_n 

DIO 5+/– GPIO_64 GPIO_63_n GPIO_63 

DIO 6+/– GPIO_42 GPIO_42_n GPIO_41_n 

DIO 7+/– GPIO_56_CC GPIO_55_n GPIO_56_n_CC 

DIO 8+/– GPIO_54_n GPIO_54 GPIO_55 

DIO 9+/– GPIO_39_n_CC GPIO_39_CC GPIO_38_n_CC 

DIO 10+/– GPIO_58_CC GPIO_57_n_CC GPIO_57_CC 

DIO 11+/– GPIO_59_CC GPIO_58_n_CC GPIO_59_n_CC 

DIO 12+/– GPIO_51_n GPIO_51 GPIO_52 

DIO 13+/– GPIO_36 GPIO_35_n GPIO_35 

DIO 14+/– GPIO_53_n GPIO_53 GPIO_52_n 

DIO 15+/– GPIO_37_CC GPIO_36_n GPIO_37_n_CC 

PFI 1+/– GPIO_43_n GPIO_43 GPIO_44 

PFI 2+/– GPIO_47 GPIO_46_n GPIO_46 

PFI 3+/– GPIO_65_n GPIO_65 GPIO_64_n 

STROBE+/– GClk_LVDS — — 

CLK OUT+/– — GPIO_34_n GPIO_34 

(если 
разрешено) 



© National Instruments Corporation   11   Руководство пользователя и технические характеристики NI 6583 

Кабели и аксессуары для подключения 
Используйте экранированный кабель NI SHC68-C68-D4 (шифр изделия NI 781013-

01) для подключения к разъему DDC A. Кабель NI SHC68-C68-D4 разработан для 

высокоскоростной передачи цифровых сигналов по несимметричным линиям. 

Кабель экранирован и имеет индивидуальные микрокоаксиальные линии 50 Ом для 

каждого сигнала. 

Используйте экранированный кабель NI SHB12X-B12X (шифр изделия NI 192344-

01) для подключения к разъему DDC B. Этот кабель разработан для 

высокоскоростной передачи цифровых сигналов по дифференциальным линиям 

 

Внимание Для обеспечения соответствия характеристик требованиям 

электромагнитной совместимости, приведенным в разделе Технические 

характеристики данного документа, NI 6583R должен использоваться с 

экранированными кабелями и аксессуарами Не используйте неэкранированные 

кабели или аксессуары, если только они не установлены в экранированный бокс с 

соответствующим образом спроектированными и экранированными портами 

ввода-вывода и подключены к NI 6583R экранированным кабелем. Если 

неэкранированные кабели или аксессуары не установлены должным образом и не 

экранированы, приведенные характеристики электромагнитной совместимости NI 

6583R не гарантируются. 

Следующие кабели и аксессуары NI не обладают должными свойствами 

экранирования для обеспечения электромагнитной совместимости при 

использовании с NI 6583: 

 NI CB-2162 – аксессуар для несимметричных линий цифрового ввода-вывода  

 NI SHC68-H1X38 – кабель для высокоскоростной передачи цифровых данных 

с свободными оконечными подключениями 

 NI SMA-2164 – аксессуар для прототипирования NI 656X 

 NI SHB12X-H3X24 – кабель с дифференциальными линиями и свободными 

концевыми гнездами (LA) для высокоскоростного цифрового ввода-вывода  

Использование аксессуаров 
 

Примечание Используете ли вы кабели и аксессуары NI или разрабатываете 

собственные, вам следует надлежащим образом заделывать концы кабеля, чтобы 

избежать некорректных измерений, вызванных отражением и выбросами сигнала. 

Аксессуары для несимметричных линий 
NI рекомендует использовать NI CB-2162 для сигналов цифрового ввода-вывода, 

передаваемых по несимметричным линиям, этот аксессуар обеспечивает доступ к 

68-контактному разъему DDC A и возможность согласования каналов цифрового 

ввода-вывода. Кроме того, NI CB-2162 предоставляет платформу для 

прототипирования схем и тестирования устройств. NI CB-2162 разработан 

специально для использования с несимметричными линиями устройств. Для 

получения дополнительной информации о NI CB-2162 обратитесь к руководству NI 

CB-2162 User Guide. 
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NI предлагает также блок NI SMB-2163 для производимых National Instruments 

генераторов/анализаторов цифровых сигналов, передаваемых по несимметричным 

линиям. NI SMB-2163 предлагает коаксиальные разъемы SMB для каждого канала 

разъема DDC A, обеспечивая простое подключение к другим устройствам для 

тестирования и отладки. Для получения дополнительной информации о NI SMB-

2163 обратитесь к руководству NI SMB-2163 User Guide. 

На рисунках 8 и 9 показаны подключения разъема DDC A для несимметричных 

линий к NI CB-2162 и NI SMB-2163, соответственно, с помощью кабеля NI SHC68-

C68-D4. 

Рисунок 8. Подключение аксессуара NI CB-2162  

 

1. Шасси PXI/PXI Express с NI 6583R 
2. Кабель NI SHC68-C68-D4 

3. Аксессуар NI CB-2162 

 

Рисунок 9. Подключение аксессуара NI SMB-2163 

 
1. Шасси PXI/PXI Express с NI 6583R 
2. Аксессуар NI SMB-2163 

3. Кабель NI SHC68-C68-D4 
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NI SHC68-H1X38 – кабель для сигналов, передаваемых по несимметричным 

линиям, в котором линии каждого сигнала разделяются на два 0,1 дюймовых 

гнезда, по одному гнезду для сигнальной и для общей цепи. Кабель NI SHC68-

H1X38 обеспечивает простой способ подключения несимметричных линий 

высокоскоростных сигналов NI к различным типам устройств и схем для связи, 

тестирования или анализа. 

Этот кабель предлагает возможности подключения, похожие на используемые в 

типичном логическом анализаторе, так что вы можете применять его в 

приложениях логического анализа. Однако, в отличие от типичного логического 

анализатора, этот кабель позволяет также одновременно генерировать тестовые 

последовательности и собирать данные, так что вы можете использовать его в 

приложениях тестирования. На рисунке ниже показан кабель со свободными 

оконечными подключениями для цифровых сигналов, передаваемых по 

несимметричным линиям. 

 

Рисунок 10. Схема кабеля со свободными концевыми гнездами для цифровых 
сигналов, передаваемых по несимметричным линиям  

 
1. Пары проводников 
2. Съемная оплетка 

3. 68-контактный разъем DDC A 
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Аксессуары для дифференциальных линий 
Блок NI SMA-2164 представляет собой устройство для подключения сигналов, 

передаваемых по дифференциальным линиям. Этот блок позволяет просто 

подключаться к тестируемым и отлаживаемым устройствам. Для получения 

дополнительной информации об использовании NI SMA-2164 обратитесь к 

руководству NI SMA-2164 User Guide. 

На рисунке 11 показано подключение разъема DDC B для передачи сигналов по 

дифференциальным линиям к NI SMA-2164 с помощью кабеля NI SHB12X-B12X. 
 

Рисунок 11. Подключение аксессуара NI SMA-2164 

 
1. Шасси PXI/PXI Express с NI 6583R 
2. Кабель NI SHB12-B12X 

3. NI SMA-2164 

 

Кабель SHB12X-H3X24 со свободными концевыми контактами может также 

использоваться для сигналов, передаваемых по дифференциальным линиям. Кабель 

позволяет подключаться способом, аналогичным используемому в типичном 

логическом анализаторе, так что вы можете применять его в приложениях 

логического анализа. Кабель показан на рисунке 12. 
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Рисунок 12. Кабель NI SHB12X-H3X24 со свободными концевыми гнездами 

 

 
 

1. Проводники (1 × 3 группы концевых гнезд) 
2. Разъем DDC B 

3. Съемная оплетка  

 

Создание пользовательского аксессуара 
 

Для многих распространенных приложений может потребоваться создание 

пользовательского аксессуара для простого доступа к сигналам вашего 

тестируемого устройства (DUT). Если вы создаете пользовательский аксессуар для 

устройства с разъемом VHDCI DDC, вы можете приобрести ответную часть для 

кабеля VHDCI у NI. Для получения дополнительной информации о создании 

пользовательских аксессуаров обратитесь к документу Interfacing to the NI Digital 

Waveform Generator/Analyzer using the VHDCI Connector, доступному при вводе 

информационного кода rdinwa на сайте ni.com/info. Если вы разрабатываете 

пользовательский аксессуар для устройства с разъемом InfiniBand, вы также 

можете приобрести этот разъем. 

 

Примечание При разработке пользовательского кабеля с разъемом DDC B 

(779157-01) для дифференциальных линий и экранированного кабеля SHB12X-

B12X (192344-01), схема расположения контактов NI 6583 на оконечном разъеме 

– обратная. Например, сигнал, показанный на контакте 1, будет соответствовать 

контакту 73 оконечного разъема. Обратитесь к разделу Лицевая панель и схема 

расположения контактов разъемов данного документа для получения 

дополнительной информации о контактах разъемов. 
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Пример VI использования NI 6583R  
с LabVIEW FPGA  
 

Примечание Перед запуском этого примера необходимо установить программное 

обеспечение. Обратитесь к документу NI FlexRIO FPGA Installation Guide and 

Specifications для получения дополнительной информации об инсталляции вашего 

программного обеспечения. 

Инсталляция программного обеспечения NI FlexRIO Adapter Module Support 

включает примеры проектов, которые помогут вам начать создавать приложения 

LabVIEW FPGA. В данном разделе демонстрируется, как использовать 

существующий пример проекта LabVIEW FPGA для генерации и сбора отсчетов с 

NI 6583R. Для примера потребуются экранированные кабели NI SHC68-C68-D4 т 

NI SHB12X-B12X, а также аксессуары, подходящие для вашего устройства. 

Обратитесь к разделу Использование аксессуаров данного документа для 

получения дополнительной информации об аксессуарах.  
 

Примечание Доступные для вашего устройства примеры зависят от версии 

используемых вами программного обеспечения и драйвера. Для получения 

информации о версиях ПО, совместимых с вашим устройством, посетите 

страницу ni.com/info и введите информационный код rdsoftwareversion. 

Каждый пример проекта NI 6583 включает следующие элементы: 

• LabVIEW FPGA VI, который может быть скомпилирован и запущен на 

встроенной в оборудовании FPGA. 

• VI, который выполняется на компьютере под ОС Windows и взаимодействует с 

LabVIEW FPGA VI. 

 

Примечание В модуле LabVIEW FPGA адаптеры модулей NI FlexRIO 

обозначаются как «модули ввода-вывода» (IO Modules). 

Выполните следующие шаги для запуска примера VI, который генерирует сигнал 

на четных каналах вашего устройства, а затем выполняет сбор этого сигнала с 

нечетных каналов вашего устройства. 

Конфигурирование аппаратных средств 
1. Для сбора и генерации сигналов, передаваемых по несимметричным линиям, 

подключите один конец экранированного кабеля NI SHC68-C68-D4 к разъему 

DDC A на лицевой панели NI 6583, а второй конец – к несимметричным 

линиям аксессуара. Для сбора и генерации сигналов, передаваемых по 

дифференциальным линиям, подключите один конец экранированного кабеля 

NI NI SHB12X-B12X к разъему DDC B на лицевой панели NI 6583, а второй 

конец – к дифференциальным линиям аксессуара. Обратитесь к разделу 

Использование аксессуаров данного документа для получения дополнительной 

информации об аксессуарах для вашего устройства.  

2. На аксессуарах вашего устройства подключите первые восемь четных 

каналов (DIO <0..14>) к первым восьми нечетным каналам (DIO <1..15>). 
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Настройка программы 
1. Запустите LabVIEW. 

2. В окне Getting Started щелкните по пункту Find Examples для запуска 

поисковика примеров NI Example Finder. 

3. В окне поисковика примеров NI Example Finder выберите Hardware Input 

and Output»FlexRIO»IO Modules»NI 6583. 

4. Выберите NI 6583 Finite Acquisition and Generation – Simple.lvproj. 

5. В окне Project Explorer откройте NI 6583 Acquisition and Generation Simple 

(Host).vi в разделе My Computer. Откроется хост-VI. VI использует NI PXI-

7952R в качестве целевого устройства FPGA. Если вы не используете NI PXI-

7952R, выполните следующие шаги для изменения целевого устройства 

FPGA. 

 

Примечание Все примеры проектов сконфигурированы под RIO0. Если имя 

вашего устройства иное, вы должны обновить имя целевого устройства. 

Щелкните по вашему устройству в окне Project Explorer правой кнопкой мыши, 

выберите Properties и введите правильное имя целевого устройства в поле 

Resource.  

a. Выберите в меню Window»Show Block Diagram для открытия блок-

диаграммы VI. 

b. Щелкните правой кнопкой мыши по функции Open FPGA VI Reference (NI 

PXI-7952R) и выберите Configure Open FPGA VI Reference. 

c. В окне Configure Open FPGA VI Reference щелкните по кнопке Browse 

Project в разделе Open VI. 

d. В открывшемся окне Select VI раскройте дерево вашего устройства, 

выберите VI в категории вашего устройства и щелкните по кнопке OK. 

e. Щелкните по кнопке OK в диалоговом окне Configure Open FPGA VI 

Reference. 

f. Сохраните VI. 

6. На лицевой панели выберите подходящие значения для элементов управления 

Num Samples, Generation Mode, Generation Constant и DDC A Voltage 

Level. 

7. Щелкните по кнопке Run, чтобы запустить VI. NI 6583R сгенерирует сигнал 

на четных каналах вашего устройства и выполнит ввод этого сигнала с 

нечетных каналов вашего устройства. На лицевой панели хост-VI 

отображаются и сгенерированные, и собранные сигналы, как показано на 

рисунке 13. Для переключения между разъемами используйте закладки DDC 

A и DDC B в левой части лицевой панели. Если сгенерированные и собранные 

сигналы совпадают, загорается индикатор DDC x Verified?  
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Рисунок 13. Лицевая панель NI 6583 Acquisition and Generation Simple (Host) VI  

 

8. Закройте VI. 

Создание проекта LabVIEW и запуск VI на 
целевом устройстве FPGA  

В этом разделе демонстрируется создание проекта LabVIEW, FPGA VI и хост-VI 

для сбора и генерации данных, передаваемых по несимметричным линиям, на NI 

6583R. В этом упражнении демонстрируется, как откомпилировать FPGA VI для 

вашего целевого устройства и запуск VI на хост-компьютере. 

 

Примечание Перед запуском этого VI отключите все сигналы от разъемов NI 

6583R. 

Создание проекта 
1. Запустите LabVIEW или, если он уже запущен, выберите меню File»New. 

2. В диалоговом окне New выберите Project»Empty Project. Щелкните по ОК. 

Новый проект откроется в окне Project Explorer. 

3. Сохраните проект под именем Static RW with Voltage.lvproj. 

Создание FPGA VI 
1. В окне Project Explorer щелкните правой кнопкой мыши по My Computer и 

выберите New»Targets and Devices. 
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2. В окне Add Targets and Devices on My Computer выберите вариант Existing 

Target or Device и разверните целевое устройство FPGA. Отобразится целевое 

устройство. 

3. Выберите ваше устройство и щелкните по кнопке ОК. Целевое устройство и 

его свойства загрузятся в дерево проекта. 

4. В окне Project Explorer щелкните правой кнопкой мыши по целевому 

устройству FPGA и выберите New»VI. Откроется пустой VI. 

5. Выберите меню Window»Show Block Diagram для открытия блок-диаграммы 

VI. 

6. В окне Project Explorer выберите FPGA Target (RIOx, PXI-79xxR). 

7. Щелкните правой кнопкой мыши IO Module и выберите Properties. В 

категории General выберите National Instruments: NI 6583, и увидите 

доступные IP-ядра на уровне компонентов (CLIP) для NI 6583 на панели 

Component Level IP. Если информация в этой категории недоступна, 

установите флажок Enable IO Module. 
 

Примечание для получения дополнительной информации об элементах CLIP для 

NI 6583, обратитесь к разделу IP-ядра на уровне компонентов (CLIP) NI 6583 

данного документа. 

8. Выберите NI 6583 Basic Connector для использования CLIP соединения. 

Щелкните по кнопке ОК. 

9. В окне Project Explorer разверните дерево IO Module (NI 6583: NI 6583 Basic 

Connector). 

10. Выберите SE_Data_Dir, SE_Data_Rd, SE_Data_Wr, Voltage_Family, 

Set_Voltage_Family и Set_Voltage_Done и перетащите их на блок-диаграмму.  

 

Совет Вы можете выбрать несколько опций сразу, зажав клавишу <Ctrl>. 

11. Создайте цикл While вокруг всех шести узлов данных, как показано на 

рисунке 14. 

12. Подключите константу False к терминалу останова цикла While. 

13. Создайте индикаторы для выходных терминалов узлов IO 

Module\SE_Data_Rd и IO Module\Set_Voltage_Done. 

14. Создайте элементы управления для входных терминалов узлов IO 

Module\Set_Voltage_Family, IO Module\SE_Data_Dir и IO 

Module\SE_Data_Wr. 

15. В палитре функций выберите Select a VI. 

16. В окне Select the VI to Open перейдите в папку Program Files\National 
Instruments\<LabVIEW x>\examples\FlexRIO\IO Modules\ 

NI 6583\FiniteAcqGenSimple. 

17. Выберите NI 6583 Voltage Level. Щелкните по кнопке OK для перетаскивания 

и помещения файла на вашу блок-диаграмму.  

18. Щелкните правой кнопкой мыши по элементу Voltage Level и выберите 

Change to Control. 
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19. Подключите элемент управления Voltage Level к узлу IO 

Module\Voltage_Family, как показано на рисунке 14. 

20. Добавьте структуру Case вокруг узлов IO Module\SE_Data_Dir, IO 

Module\SE_Data_Rd и IO Module\SE_Data_Wr, управляемую IO 

Module\Set_Voltage_Done для предотвращения доступа ко входам и выходам 

в процессе изменения напряжения. 

Ваша блок-диаграмма должна быть аналогична показанной на рисунке 14. 
 

Рисунок 14. Блок-диаграмма Static RW with Voltage (FPGA).vi  

 
 

21. Сохраните VI как Static RW with Voltage (FPGA).vi. 

22. Закройте VI. 

23. В окне Project Explorer в разделе My Computer, разверните дерево категорий 

вашего устройства, щелкните правой кнопкой мыши по Static RW with 

Voltage (FPGA).vi и выберите Compile для компиляции файлов для вашего 

целевого устройства. 

Откроется окно Generating Intermediate Files, отображающее процесс 

компиляции.  

Откроется и запустится окно LabVIEW FPGA Compile Server. Компиляция 

занимает несколько минут. 

24. Когда компиляция завершится, щелкните по кнопке Stop Server. 

25. Щелкните по кнопке OK в окне Successful Compile Report. Закройте VI без 

сохранения изменений. 
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Создание хост-VI 
1. В окне Project Explorer щелкните правой кнопкой мыши по My Computer и 

выберите New»VI. Откроется пустой VI. 

2. Выберите в меню Window»Show Block Diagram для открытия блок-

диаграммы VI. 

3. Добавьте на блок-диаграмму функцию Open FPGA VI Reference (из палитры 

FPGA Interface). 

4. Щелкните правой кнопкой мыши по функции Open FPGA VI Reference и 

выберите Configure Open FPGA VI Reference. 

5. В окне Configure Open FPGA VI Reference выберите кнопку VI. 

6. В открывшемся окне Select VI выберите Static RW with Voltage (FPGA).vi в 

дереве категорий вашего устройства и щелкните по кнопке OK. 

7. Установите флажок Run the FPGA VI, если он еще не стоит.  

8. Щелкните по кнопке OK в диалоговом окне Configure Open FPGA VI 

Reference. Имя нового целевого устройства появится под функцией Open 

FPGA VI Reference на блок-диаграмме 

9. Добавьте цикл While на блок-диаграмму, как показано на рисунке 15. 

10. Добавьте функцию Read/Write Control (из палитры FPGA Interface) в цикл 

While. 

11. Подключите терминал FPGA VI Reference Out функции Configure Open 

FPGA VI Reference к терминалу FPGA VI Reference In функции Read/Write 

Control. 

12. Подключите терминал error out функции Configure Open FPGA VI Reference к 

терминалу error in функции Read/Write Control. 

13. Щелкните по входу Unselected функции Read/Write и выберите Voltage Level. 

14. Подключите элемент управления к входному терминалу Voltage Level. 

15. Растяните функцию Read/Write Control еще на пять узлов. Щелкните по новым 

узлам и выберите каждый из оставшихся элементов. 

16. Создайте индикаторы для выходных терминалов IO Module\SE_Data_Rd и IO 

Module\Set_Voltage_Done. 

17. Создайте элементы управления для входных терминалов  

IO Module\SE_Data_Dir, IO Module\SE_Data_Wr и  

IO Module\Set_Voltage_Family. 

18. Добавьте на блок-диаграмму функцию Close FPGA VI (из палитры FPGA 

Interface) за границей цикла While. 

19. Подключите терминал FPGA VI Reference Out функции Read/Write Control к 

терминалу FPGA VI Reference In функции Close FPGA VI Reference. 

20. Подключите терминал error out функции Read/Write Control к терминалу 

error in функции Close FPGA VI Reference. 
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21. Щелкните правой кнопкой мыши по терминалу условия цикла While и 

создайте элемент управления. Назовите его Stop. Ваша блок-диаграмма 

должна быть аналогична показанной на рисунке 15. 
 

Рисунок 15. Блок-диаграмма Data RW (Host).vi 

 

22. Сохраните VI как Static RW with Voltage (Host).vi. 

 

Запуск хост-VI 
1. Выберите Window»Show Front Panel для открытия лицевой панели VI. 

2. Щелкните по кнопке Run, чтобы запустить VI. 

3. Введите в элемент управления IO Module\SE_Data_Dir число, определяющее 

направление каналов. 0 – устанавливает канал на вход, а 1 – на выход. Каждый 

из 32 битов непосредственно управляет одним из 32 каналов. Бит 0 

соответствует каналу 0, и так далее. 

4. Подключите выходной канал ко входному или к цифровому мультиметру 
(DMM). 

5. Измените логическое состояние выходного канала и убедитесь, что 

соответствующее логическое состояние входного канала или DMM также 
меняется. 

6. Измените напряжение выходного канала с помощью элемента управления IO 

Module\Voltage_Level и убедитесь, что напряжение также изменяется на 

соответствующем входном канале или DMM. Используйте таблицу 6 для 

задания желаемого напряжения ввода-вывода с помощью элемента IO 

Module\Voltage_Level. 

7. Щелкните по кнопке Stop на лицевой панели и закройте VI. 
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Таблица 6. Элемент управления IO Module\Set Voltage  
 

Элемент управления  

IO Module\Set Voltage 

Напряжение ввода-вывода 

0 1,2 В 

1 1,5 В 

2 1,8 В 

3 2,5 В 

4 3,3 В 

 

IP-ядра на уровне компонентов (CLIP) NI 6583 
Модуль LabVIEW FPGA предоставляет возможность интеграции HDL IP под 

названием CLIP. Устройства NI FlexRIO поддерживают два типа CLIP: user-defined 

(определяемый пользователем) и socketed (соединительный). 

• Определяемый пользователем CLIP позволяет пользователям вставлять HDL 

IP в целевое устройство FPGA, позволяя коду VHDL непосредственно 

взаимодействовать с FPGA VI. 

• Соединительный CLIP предоставляет такую же функциональность интеграции 

с IP, как и определяемая пользователем, но позволяет также CLIP 

взаимодействовать непосредственно с внешними схемами FPGA. 

Соединительный CLIP адаптера модуля позволяет вашему IP непосредственно 

взаимодействовать с FPGA VI и внешним интерфейсом разъема адаптера 

модуля. 

На рисунке 16 показана взаимосвязь FPGA VI и CLIP. 
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Рисунок 16. Взаимосвязь CLIP и FPGA VI 

 

NI 6583 поставляется в вариантах с соединительными CLIP, которые добавляют 

ввод-вывод модуля в проект LabVIEW. NI 6583 поставляется в следующих 

вариантах CLIP: 

• NI 6583 Basic Channel CLIP — Обеспечивает доступ по чтению/записи для 

всех несимметричных линий DDC A и всех дифференциальных линий DDC B 

с помощью простого интерфейса, основанного на каналах. У каждой линии 

ввода-вывода есть сигнал управления направлением. Этот CLIP предоставляет 

тактовый сигнал для экспорта на каждый разъем. Тактируемые входные 

данные из NI 6583 передаются в LabVIEW FPGA для использования в FPGA 

VI. Этот CLIP позволяет также индивидуально инвертировать тактируемые 

выходные сигналы. 

• NI 6583 Basic Connector CLIP — Обеспечивает доступ по чтению/записи для 

всех несимметричных линий DDC A и всех дифференциальных линий DDC B. 

Доступ к линиям данных на DDC A обеспечивается данными типа U32, а на 

DDC B данными типа U16 в LabVIEW FPGA. У каждой линии ввода-вывода 

есть сигнал управления направлением. Этот CLIP позволяет также 

индивидуально инвертировать тактируемые выходные сигналы. 

• NI 6583 DDR Connector CLIP — Обеспечивает доступ по чтению/записи для 

всех несимметричных линий DDC A и всех дифференциальных линий DDC B. 

Доступ к линиям данных на DDC A обеспечивается данными типа U32, а на 

DDC B данными типа U16 в LabVIEW FPGA. Данные по каждому фронту 

тактового сигнала представляются в виде "нарастающего" или "спадающего". 

У каждой линии ввода-вывода есть сигнал управления направлением. Этот 

CLIP позволяет также индивидуально инвертировать тактируемые выходные 

сигналы. 
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Внимание Все варианты CLIP включают IP для управления напряжением и 

направлением. Напряжение определяется 10-разрядным кодом ЦАП или 

перечислительным типом данных. Вы должны использовать этот IP, чтобы 

предотвратить повреждение вашего NI 6583 и вашей системы. 

Обратитесь к справке NI FlexRIO Help для получения дополнительной информации 

об элементах NI FlexRIO CLIP, конфигурировании NI 6583 с соединительными 

CLIP, и списком доступных сигналов соединительных CLIP. 

 

Технические характеристики 
В этом разделе приводятся технические характеристики адаптера модуля NI 

FlexRIO (NI 6583). Используйте эти характеристики совместно с приведенными в 

документе NI FlexRIO FPGA Module Installation Guide and Specifications. Для 

получения дополнительной информации о безопасности и электромагнитной 

совместимости обратитесь к документу Read Me First: Safety and Electromagnetic 

Compatibility, поставляемому в комплекте с вашим оборудованием или доступному 

на странице ni.com/manuals. 

Эти технические характеристики действительны при температуре 25 °С, если не 

указано иное. 

 

Характеристики каналов 
 

Количество разъемов Один VHDCI (DDC A для несимметричных 

каналов ввода-вывода) 

Один InfiniBand (DDC B для 
дифференциальных каналов ввода-вывода) 

Количество каналов цифрового ввода-

вывода 

35 на DDC A (32 несимметричных канала 

данных,  

3 несимметричных канала PFI);  

19 на DDC B (16 дифференциальных 

каналов данных, 3 дифференциальных 
канала PFI) 

Управление направлением линий 

цифрового ввода-вывода 

Индивидуально для канала 

Минимально необходимая задержка 

изменения направления  

9 нс, только для сигналов несимметричных 

каналов 

Количество входных терминалов для 

тактовых импульсов 
2, STROBE на DDC A и STROBE на DDC B 

Количество выходных терминалов для 

тактовых импульсов 

2, CLK OUT на DDC A и CLK OUT на DDC 

B 
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Несимметричные каналы (DDC A) 
(Совместимы с шинными приемопередатчиками TI SN74AVC2T245) 

Количество программируемых уровней 

напряжения ввода-вывода 
1 VCC 

 

Примечание Предоставляемые элементы CLIP обладают способностью 

программировать уровень напряжения по логическим семействам (1,2В; 1,5В; 

1,8В; 2,5В и 3,3В) или по коду ЦАП (10-разрядному). Уровень напряжения 
общий для несимметричных входных и выходных сигналов. 

 

Диапазон напряжения от 1,2 В до 3,3 В 

Разрешение 10 бит, ном. 

Коэффициент преобразования 2,69 мВ / код ЦАП, ном. 

Смещение 3,63 В, ном. 

Состояние при включении питания Драйверы отключены, импеданс 

относительно общего 50 кОм, VCC = 3,63 В 

 

Примечание Вы должны устанавливать напряжения после каждого включения 
питания перед выполнением каких-либо операций.  

 

Типичная частота обмена данными 

1,8 В; 2,5 В; 3,3 В 300 Мб/c 

1,5 В 280 Мб/c 

1,2 В 240 Мб/c 

 

Генерация (каналы данных, тактовые и PFI) 
 

Таблица 7. Уровни генерации напряжения (с нагрузкой 100 мкA) 
 

Уровни 

генерируемых 

напряжений 

Низкие уровни напряжений Высокие уровни напряжений 

Характеристика Максимальная Минимум Характеристика 

VCC  

от 1,2 В до 3,3 В 

0 В 200 мВ VCC - 200 

мВ 

VCC 

 

Выходное сопротивление 50 Ом, ном. 

Максимальный постоянный ток нагрузки 

на канал 
 

VCC 1,2 В ±6 мА 

VCC от 1,4 В до 1,6 В ±12 мА 

VCC от 1,65 В до 1,95 В ±16 мА 
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VCC от 2,3 В до 3,3 В ±18 мА 

Защита выхода Несимметричные каналы ввода-вывода 

могут выдерживать постоянное короткое 

замыкание с любым напряжением между -

0,5 В и VCC + 0,5 В, если ток не превышает 
30 мА 

 

Сбор данных (каналы данных, STROBE и PFI) 
 

Таблица 8. Пороги входных напряжений 
 

Уровни входных  

напряжений 

Порог низкого  

уровня 

Порог высокого  

уровня 

Минимум Максимум 

VCC от 1,2 В до 1,95 В 0,35 x VCC 0,65 x VCC 

VCC от 1,95 В до 2,7 В 0,7 В 1,6 В 

VCC от 2,7 В до 3,3 В 0,8 В 2,0 В 
 

Входное сопротивление 50 кОм, ном. 

Защита входа от -0,5 В до 4,6 В 

 
Примечание Внутренние диодные ограничители вне диапазона от 0 В до VCC 

могут начинать открываться. 

 

Каналы LVDS (DDC B) 
 

(Совместимы с драйверами (приемниками и передатчиками) для дифференциальных 

линий TI SN65LVDM180) 

Количество программируемых уровней 

напряжения ввода-вывода 

Нет 

Состояние при включении питания Драйверы отключены, импеданс между 

дифференциальными линиями 100 Ом;  

300 кОм относительно 3,3 В 

Типичная частота обмена данными 300 Мб/c 
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Генерация (каналы данных, тактовые и PFI) 
 

Таблица 9. Уровни генерируемых напряжений (под нагрузкой 50 Ом) 
 

Напряжение смещения Дифференциальное напряжение 

Мин. Тип.  Макс. Мин. Тип.  Макс. 

1,125 В 1,2 В 1,375 В 247 мВ 340 мВ 454 мВ 
 

 

Выходное сопротивление 100 Ом, дифференциальное, ном. 

Защита выхода 

Все каналы могут выдерживать постоянное 

короткое замыкание с любым напряжением 
между -0,5 В и 4,0 В 

 

Примечание Внутренние диодные ограничители вне диапазона от 0 В до 4,0 В 

могут начинать открываться. 

Сбор данных (каналы данных, STROBE и PFI) 
 

Таблица 10. Уровни входных напряжений 
 

Порог напряжения Диапазон напряжения 

Макс. Мин. Макс. 

-50 мВ 0 В 2,4 В 
 

Входное сопротивление 100 Ом, дифференциальное, ном. 

Защита входа Все каналы могут выдерживать постоянное 

короткое замыкание с любым напряжением 
между -0,5 В и 4,0 В 

 

Примечание Внутренние диодные ограничители вне диапазона от 0 В до 3,3 В  

могут начинать открываться. 

Каналы MLVDS (DDC B) 
( Совместимы с драйверами (приемниками и передатчиками) для дифференциальных 

линий TI SN65MLVD207) 

Количество программируемых уровней 

напряжения ввода-вывода 

Нет 

Состояние при включении Драйверы отключены, импеданс между 

дифференциальными линиями 100 Ом 

Защита от сбоев Тип 2 

Типичная частота обмена данными 200 Мб/c 
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Генерация (каналы данных, тактовые и PFI) 
 

Таблица 11. Уровни генерации напряжения (с полной нагрузкой 50 Ом) 
 

Напряжение смещения Дифференциальное напряжение 

Мин. Макс. Мин. Макс. 

0,8 В 1,2 В 480 мВ 650 мВ 
 

Выходное сопротивление импеданс между дифференциальными 

линиями 100 Ом, ном. 

Защита выхода Все каналы могут постоянное короткое 

замыкание с любым напряжением между -
1,4 В и 3,8 В. 

 

Сбор данных (каналы данных, STROBE и PFI) 
 

Амплитуда дифференциального входного 

напряжения 
от 0,05 В до 3,3 В 

Положительный дифференциальный 

порог 
150 мВ 

Отрицательный дифференциальный порог 50 мВ 

Входной импеданс 
импеданс между дифференциальными 

линиями 100 Ом, ном. 

Входной диапазон от -1,4 В до 3,8 В 

 

Питание 

Максимальные требования к питанию при переключении половины каналов данных с 100% 

быстродействием и половины с 50% быстродействием. +12 В – максимум при генерации, а 

+3,3 В – максимум при сборе данных.  

 

+12 В 215 мА, 2,6 Вт 

+3,3 В 850 мА, 2,8 Вт 

VccoB 275 мА, 690 мВт 

 

Физические характеристики 
 

Размеры  12,9  2,0  12,1 см 

Вес 284 г 

Разъемы лицевой панели Один 68-контактный разъем VHDCI и один 

73-контактный разъем InfiniBand. 
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Условия эксплуатации 
NI 6583 предназначен для использования только внутри помещения. 

Диапазон рабочих температур от 0 °C до 55°C (протестировано в 

соответствии с IEC-60068-2-1  
и IEC-60068-2-2.) 

Относительная влажность от 10% до 90%, без конденсата 

(протестировано в соответствии с  
IEC-60068-2-56) 

Максимальная высота над уровнем моря 2 000 м (при температуре окружающей 

среды 25 °C) 

Степень загрязнения 2 

Условия хранения  

Диапазон температур при хранении от -20 °C до 70 °C (протестировано в 

соответствии с IEC-60068-2-1 и  
IEC-60068-2-2.) 

Относительная влажность от 5% до 95%, без конденсата 

(протестировано в соответствии с  
IEC-60068-2-56) 

 

Примечание Очищайте устройство мягкой, неметаллической кисточкой. 

Убедитесь, что устройство полностью сухо и свободно от загрязнений, прежде 

чем продолжить его эксплуатацию. 

Глоссарий 
Максимальные и минимальные характеристики гарантированно не будут 

превышены при определенных условиях эксплуатации и включают влияние 

температуры и неопределенности, если не указано иное. 

Типовые характеристики – не гарантируемые значения, представляемые 

большинством (3σ) устройств в определенных условиях эксплуатации и 

включающие влияние температуры и неопределенности, если не указано иное. 

Характерные значения не гарантируются и описывают усредненное устройство, 

работающее при комнатной температуре. 

Номинальные характеристики – не гарантируемые значения, имеющие отношение к 

использованию продукта и обеспечивают ожидаемую производительность 

продукта. 

 

Соответствие требованиям и сертификаты 
 

Безопасность 
 

Изделие соответствует требованиям следующих стандартов по 

электробезопасности оборудования для измерений, управления и лабораторного 

применения: 
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• IEC 61010-1, EN 61010-1 

• UL 61010-1, CSA 61010-1 

 

Примечание: Информацию о сертификатах UL и других сертификатах вы можете 

найти на товарной этикетке или в разделе Онлайн-Сертификация.. 

 

Электромагнитная совместимость 
Изделие удовлетворяет требованиям следующих стандартов по электромагнитной 

совместимости (ЭМС) лабораторного электрооборудования для измерений и 

автоматизации: 

 EN 61326-1 (IEC 61326-1): Класс А излучений; Минимальные требования к 

помехозащищенности 

 EN 55011 (CISPR 11): Группа 1; Класс А излучений  

 AS/NZS CISPR 11: Группа 1; Класс А излучений 

 FCC 47 CFR Часть 15B: Класс А излучений 

 ICES-001: Класс А излучений 

 

Примечание За информацией о стандартах, применявшихся для оценки 

электромагнитной совместимости данного продукта, обратитесь к разделу 

Онлайн -сертификация 

 

Примечание Для соответствия нормам EMC работайте с данным продуктом 

согласно документации и только с использованием экранированных кабелей  

NI SHC68-C68-D4 (1 м), NI SHB12X-B12X (1 м) и экранированных аксессуаров. 

 

Внимание Для обеспечения указанной электромагнитной совместимости прежде, 

чем использовать NI 6583 версии MLVDS, вы должны установить уплотнители 

для защиты от ЕМС (шифр изделия NI 746228-01) на обе стороны вашего  

NI 6583.  

 

Соответствие требованиям Совета Европы   
Изделие соответствует основным требованиям следующих директив СЕ: 

• 2006/95/EC; Директива по безопасности низковольтного оборудования 

• 2004/108/EС; Директива по ЭМС. 

 

Oнлайн-сертификация 
Для получения дополнительной информации о соответствии нормативным 

требованиям обратитесь к документу «Декларация о соответствии» (DoC). Для 

получения сертификатов и Декларации о соответствии (DoC) этого изделия 

посетите страницу ni.com/certification, выполните поиск по серии и 

номеру модели, и щелкните по соответствующей ссылке в столбце Certification. 
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Охрана окружающей среды 
NI разрабатывает и производит продукцию с учетом требований по защите 

окружающей среды и принимает во внимание, что отказ от использования 

некоторых опасных веществ при изготовлении изделий полезен как для среды 

обитания, так и для потребителей. 

Дополнительная информация по защите окружающей среды находится на странице 

NI and the Environment по адресу ni.com/environment. Эта страница содержит 

положения и директивы по охране окружающей среды, которые соблюдает 

компания NI, а также другая информация о защите окружающей среды, не 

включенная в настоящий документ. 

Утилизация электрического и электронного 
оборудования 

Пользователям ЕС: По истечении срока службы любая продукция должна быть 

отправлена в центр по переработке электрического и электротехнического 

оборудования (WEEE). Для получения информации о WEEE центрах по 

переработке, инициативах National Instruments по WEEE, а также о соответствии 

с WEEE Директивой 2002/96/ЕС обратитесь на сайт 

ni.com/environment/weee. 

 

 
(Для получения информации о директиве по ограничению вредных веществ в 
Китае, обратитесь на страницу ni.com/environment/rohs_china.) 

 

Куда обратиться за поддержкой 
Веб-сайт National Instruments является полноценным ресурсом вашей технической 

поддержки. На ni.com/support вы можете получить любую информацию, 

начиная с выявления неисправностей и ресурсов для самостоятельного поиска 

ответов по разработке приложений и заканчивая возможностью поддержки по 

электронной почте либо по телефону специалистами NI. 

Штаб-квартира корпорации National Instruments располагается по адресу 11500 

North Mopac Expressway, Austin, Texas, 78759-3504. National Instruments имеет 

также офисы по всему миру для обеспечения технической поддержки. Для 

получения поддержки по телефону в США создайте запрос на странице 

ni.com/support и следуйте инструкциям или позвоните по номеру 512 795 

8248. Для получения поддержки по телефону вне Соединенных Штатов вы можете 

также посетить раздел Worldwide Offices на сайте ni.com/niglobal для 

доступа к веб-сайтам филиалов, где имеется обновляемая контактная информация, 

телефоны службы поддержки, адреса электронной почты и информация о текущих 

событиях. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
LabVIEW, National Instruments, NI, ni.com, логотип корпорации National Instruments и логотип с орлом являются 
торговыми марками корпорации National Instruments. За более подробной информацией о торговых марках 
корпорации National Instruments обратитесь к разделу Trademark Information на сайте 
ni.com/trademarks. Названия других упомянутых в данном руководстве изделий и производителей 

также являются торговыми марками или торговыми именами соответствующих компаний. Для получения 
информации о патентах, которыми защищены продукция или технологии National Instruments, выполните 
команду Help»Patents из главного меню вашего программного обеспечения, откройте файл patents.txt на 

имеющемся у вас компакт-диске или зайдите на сайт ni.com/patents. Обратитесь к документу Export 

Compliance Information на сайте ni.com/legal/export-compliance за глобальными принципами 

торговой политики National Instruments. 

© 2010-2011 National Instruments Corporation. All rights reserved. 
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